Instrumentacion Virtual con LabVIEW

]
5 5 | —
INSTRUMENTS

Objetivos del Curso

« Comprender los componentes de un instrumento virtual

* Introducir LabVIEW y las funciones comunes de LabVIEW
* Construir una aplicacion simple de adquisicion de datos

* Crear una subrutina en LabVIEW

* Trabajar con Arreglos, Clusters y Estructuras

* Aprender sobre impresiones y caracteristicas de
documentacion

* Desarrollo en arquitecturas de programacion.
* Publicar Vls en el navegador

INSTRUMENTS




Seccion |

Términos de LabVIEW
Componentes de aplicacion de LabVIEW

Herramientas de programacion de LabVIEW
Crear una aplicacion en LabVIEW

Programas de LabVIEW se llaman instrumentos virtuales (VIs)

Panel frontal
* Controles = entradas
* Indicadores = salidas

Diagrama de bloque
* Programa de acompafiamiento
para el panel frontal
« Componentes “cableados”
entre si




Panel frontal de VI

EENER CRENE N EIN & Temperature Running Average. vi Front Panel *

del panel frontal File Edi Tocls Browse Window Help ' Icono
— /
Control
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VI Diagrama de bloque
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Vis Expreso, Vis y Funciones
* Vs Expreso: Vls interactivos con pagina de dialogo
configurable

* Vls estandar: VIs modulares y personalizables mediante
cableado

* Funciones: Elementos fundamentales de operacion de

Tulkiply

Funcion

VI Expreso

Paleta de controles y funciones

Paletas de control

(Ventana del panel frontal) |

i

um Chrls Buttons Text Chrls User Ctrls

Murm Inds LEDs Text Inds iaraph Inds All Contrals

% | Quearn] & Paleta de funciones
(Ventana de diagrama de bloque)
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@
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Input Analysis Output User Libraries

& l

All Functions




Paleta de Herramientas

» Paleta flotante

» Utilizado para operar y modificar
objetos en el panel frontal y en el
diagrama de bloques.

= | | Herramienta de seleccion automatica

Herramienta de operacion ™ Herramienta de desplazamiento

Herramienta de posicionamiento @ Herramienta de punto de paro

th
&
=

y redimension 48 Herramienta de prueba
Herramienta de etiquetado 4 Herramienta para copia de color
? Herramienta de cableado % 4 Herramienta para colorear

Herramienta de menu (atajo)

Barra de herramientas de Estado
(][] @[n][2] ba]@]os | 30t application Fort [~ {[5a~]
EI Boton de ejecucion (Run)

Eehe e |

Boton de ejecucion continua Botones adicionales en
(Continuous Run) el diagrama de la barra
Cancelacion de ejecucion de herramientas

(Abort Execution) ) . L
. . i =7 Botdn de ejecucion resaltada
EI Boton de pausa/continuacion @ (Highlight Execution)

. Configuracion de textos Boton de entrada al ciclo
13pt Application Fank |vi (TeXt Settings) E (Step |nt0)

Alineamiento de objetos [ Boton sobre (Step Over)
(Align Objects)
Z=<] Distribucion de objetos E Bot6n de salida del ciclo
21 (Distribute Objects) (Step Out)

Reordenamiento

Redimensionamiento de objetos
= de panel frontal (Resize Objects)




No borre esta Diapositiva

Abray Ejecute un Instrumento Virtual

Buscador de Ejemplos

Browse  searcn | submit | Double-clck an example to apen . Description
| 17 Examples match your search erkeria | Determines the result of filtering and |
Enter keywordis) 20 FFT of & Puise.vi windor a generated signal. This
ignals sxampls also displays the power
Advanced Peak Detector .+ spectrum For the generated sianal,
advanced Threshold Peak Detector i
arbitrary Wave Display i huate: ou must have the LabVIEW
roltrary Wave Depay. Full or Professional Development
Bandimited Signal Genaration.vi Systems to run this example.
DC Certered Spectrum.vi
Echo Detector i
Function Generator with FM.vi
Mutione with Amplitudesvi
Parsevals Theorem.vi
Peak Detection and Display vi

_ioixi

Double-click keyword(s)

accelerometer
access

Vibration Analysis. i
waveform Generation Using Formula. vi &
Dynamic Sianal Analyzer i

All hardware compatible with selected
Detect Signals.vi example. Doble-click 2 device to view
Route Interrupts ko Signal Queue. vi “Web information

Search For:
[arry of the words ~

I nciude i com examples

Hardware

o hardware Found ]

=
Setup. . Help Close




Creando un VI

Ventana de Panel Frontal

Terminales
de
Control

Help
Description and Tip...
Set Breakpaint

Create »
Replace

Ventana de Diagrama de Bloques

g

Terminales
BB de
Subtract Indicador

e 123

(=13

&= Context Help

Subtract

Computes the difference of
the inputs.

lick here for more help.
7 PI Z

Cl




Consejos Para Conectar — Diagrama de Bloques

“Punto Caliente” de Cableado Haga Clic para Seleccionar los Cables
@ B me B
mmeefy oy boe ety
single-click double-click triple-click
Utilice la Ruta Automatica Limpiando el Cableado
del Cable

e Create Wire Branch
1-2 Delete Wire Branch

[ Insert

No Borrar Esta Diapositiva




Programando el Flujo de Datos

+ El diagrama de bloque se ejecuta
dependiendo del flujo de los datos; ~ Pumber 1
el diagrama de bloques NO se
ejecuta de izquierda a derecha

Resulk 1

21123

+ Elnodo se ejecuta cuando los
datos estan disponibles para
TODOS los terminales de entrada.

Randaorn Murmber (0-1)

Sine Resulk 2

'ﬁ" 123

* Los nodos suministran datos a
todos los terminales de salida
cuando termina.

Opciones de Ayuda

B> Context Help

Contexto de la Ayuda
« Ayuda en linea
 Congelar Ayuda
 Ayuda del Diagrama Simple/Co
Ctrl+ H

WISA session

Referencias en Linea
* Todos los menus en linea

« Clic en las funciones del diagrama para tener acces o directo a
la informacion en linea.




No Borrar Esta Diapositiva

Ejercicio 1 — Convertir de °C a °F

B> Convert C to F {Ex1).¥i Front Panel *

File Edit ©Operate Tools Browse Window Help Cor
@ ||| 13pt Application Fort |v| ;mvl Tu:vl
Al

10



Técnicas para Eliminar Errores

* Encontrando los Errores

Haga clic en el boton de “correr” que esta roto;
> Aparece una ventana mostrando los errores

» Resaltar la Ejecucion
Haga clic en el boton de ejecucion resaltada; el
flujo de datos es animado utilizando burbujas.
o Los valores se despliegan en los cables.

» Herramienta de Prueba

Haga clic con el botdn derecho sobre el cable para
exhibir la ventana de prueba y asi mostrar los
datos mientras fluyen por el segmento de cable.

También puede seleccionar la herramienta de
prueba desde la paleta de herramientas y hacer un
clic en el cable.

Seccion Il - SubVls

% Sample Program.vi Front Panel*  [=|[B]X]

File Edt Operats Tools Browss Window Help =
[ ] @ [1n] [ 130t Appication Font "l
]

[ ] Que es Un SUbW\ Ele Edit Operste Tools Bhowse MWindow Help
* Elaboracion de un icono ‘

y un conector para un
subVI

« Utilizando un VI como
un subVI

11



Nodos del Diagrama de Bloques

Icono Nodo Expandible Nodo Expandido

=L 2 H

i

b amplitude

b error in (no errar)

v frequency
offset

* VI de Generador de Funciones i
« El mismo VI, visto en tres maneras e

diferentes. e
* El campo amarillo designa un VI Estandar. D“glt;
* El campo azul designa un VI Expreso

SubVils

*Un SubVI es un VI que puede ser utilizado dentro de
otro VI

* Similar a una subrutina
*Ventajas
—Modular
—Facil para eliminar errores
—No tiene que crear cédigos
—Requiere menos memoria




Icono y Conector

b ode HT'E'I‘“F Temperature

lTemp

*Unicono representa un VI en otro
diagrama de bloque

* El conector muestra terminales
‘ disponibles para transferir datos

SubVils

[ Temperature Running Average.vi Block Diagram

File Edit Operate Tools Browse Window Help

@ IIIME';,:H L3pt-Application Fort |v'|=mvl|7u:v|

L1 Compgund Arithmetic Temperature History

b Temp Scale
Temperature ¥

HTemp

b Temp Scale
Ternperakure

Wit Unkil Mext ms Multiple

millisecond mulkiple g L )
| )

13



Pasos para crear un SubVI

*Crear el icono

*Crear el conector

* Asignar terminales

«Salvar el VI

*Insertar el VI dentro del VI principal

Crear el Icono

* Haga click derecho sobre el icono en el
diagrama de bloque o panel frontal

¥/ Icon Editor,

File Edit Help

B & W Copy From:

& Black & White
&3 16 Colors

o} 256 Colors

16 Colors

|:| I Show Terminal Is
oK |

256 Colors p— |

S
t1=:2_/.y21 Help |
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Crear el Conector

Haga click derecho sobre el icono (solamente en el panel frontal)

FEX

File Edit Operate Tools Browse Window Help =
E WI Properties. ..
P p—

[>]@] @@ 13pt Appication Fort |~ |[8ov] .u_vl V1 Fropert

Find &ll Instances

add Terminal

Remaove Terminal
Patterns 4
Raokakte 90 Degrees

Flip Horizonkal

Flip Vertical

Disconnect All Terminals

Disconnect This Terminal
This Connection Is 4

Asignar Terminales

File Edit ©Operate Tools Browse ‘Window Help

@E 13pt Application Fonk |vl g

15



Salvar el VI

* Escoja un sitio 0 un félder facil de recordar
* Organizar por funcionalidad

-salvar los VIs similares en un mismo directorio (Ej. Utilidades
matematicas)
* Organizar por aplicacion
— Salvar todos los Vls Usados para una Aplicacién Especifica dentro de
un directorio o un archivo de libreria (Ej. Lab 1 — Frecuencia de

respuesta)

+ Archivo de libreria (.llbs) combina todos los VIs en un solo archivo, ideal para
transferir aplicaciones enteras a través de computadoras

Insertar el SubVI dentro de un VI Principal

Acceder subVIs creados por el usuario T Q] 5
Funciones >> All Functions >> Seleccione B o)
un VI o B
arrastre el icono hasta el diagrama deseado =
s
=
Fle Edit Operaie ook Brov =

b & r|RE
REEOmE 28 ﬁ
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Tips para trabajar en LabVIEW

* Atajos desde el teclado
— <Ctrl-H> — Activa/Desactiva la Ventana de Ayuda
— <Ctrl-B> — Remueve todos los cables rotos del diagrama de bloques
— <Ctrl-E> — Cambiar entre el Panel Frontal y el Diagrama de Bloques
— <Ctrl-Z> - Deshacer cambios — Undo (también disponible en el menu

de edicion)

* Herramientas » Opciones... — Establecer Preferencias en
LabVIEW

* Propiedades del VI - Configurar la Apariencia del VI,
Documentacion, etc.

INSTRUMENTS

Seccidn lll - Adquisicion de Datos

« Datos de adquisicion (DAQ en ingles)
basicos ‘

Dispositivo DAQ

* Conectando Seriales |
* Aplicacién simple con DAQ

Sensores |
Cable

Bloque de Terminales

Computadora

NG

R

INSTRUMENTS

17



Adquisicion de Datos en LabVIEW

= NI Measurements

ERENE D

DAQ - Adquisicion De Datos

Adquisicion de temperatura utilizando el Asistente de DAQ
(DAQ Assistant) g

18



Terminologia De la Adquisicion De Datos

* Resolucion — Determina cuantos diferentes cambios de voltajes
pueden ser medidos

— Resolucion mas grande = Una representacion mas exacta de la
sefial
. Rango — Voltajes minimos y maximos
- Rango mas pequefio = Una representacion mas precisa de la
sefial

* Gain (ganancia) - Amplifica o atenta la sefial para un mejor
ajuste del rango

No Borrar esta Diapositiva
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Conexiones de Hardware

SC-2075
BNC-2120

NI-ELVIS

Bl S LTI

Ejercicio 2 — Adquisicion de Datos Simples

Complete el VI de conversion de C a F (Conversion C a
F.vi), y después cree el VI Termémetro (Thermometer.vi).

&

20



No Borrar esta Diapositiva

Seccioén IV - Ciclos y Graficas

*For Loop (Ciclo Para)

* While Loop (Ciclo Mientras)
* Gréficas
» Multiplots

21



Ciclos

Random Mumber {0-1)

* Ciclo Mientras &=
LT

— Tiene una Terminal de lteracién
— Siempre corre al menos una vez

— Corre de acuerdo a la Terminal
Condicionante

« Ciclos Para LooHR

— Tiene una Terminal de Iteraciéon

— Corre de acuerdo a la entrada
N de la Terminal de Conteo

Random Mumber {0-13
1)

Ciclos (cont.)

1. Seleccionar el ciclo 2. Encerrar c6digo que va a ser repetido

E

3
DAQ Assistant
data

Temperakure

CILIE 5

=
.|




1 4 L]
ra I ca S «Hcontrals ==

g o =

=i,

Text Cirls User Ctrls
-'—> B Q 3
== =
— —HGraph Indicators
Num Inds LEDs Text Inds Graph Inds

whaveform Chart

Gréfica de forma de onda —
indicador numerico especial
gue puede mostrar una
historia de valores

Controles >> Indicadores de
Gréficas >> Gréfica de
forma de onda

Temperature

INSTRUMENTS

— |
Cableando Datos a las Graficas

Grafica de diagrama simple  Grafica de diagrama mdltiple

[ Temp Scale
Temperature

b Temp Scale
S —

b Termp Scale
Temperature ¥

Naveform Chart| I

Merge Signals ZE

aveform Chart

N

ald

b Temp Scale
Temperature Etop]
m s1er {3

NATIONAL
INSTRUMENTS




Ejercicio 3 — Usando ciclos

Estudiantes construyen el VI Ejemplo de Ciclo.vi.

g 5 Untitled 4 Blo EEx

! Loop T T
se Window Heb

[ f

File Edit Oper Wi Hel
el [T mmtor ]

Seccion V - Arreglos & Manejo de Archivo (File 1/0)

« Construir arreglos manualmente

* Dejar que LabVIEW construya arreglos
automaticamente

« Escribir a un archivo de hoja de célculo (spreadsheet)
* Leer desde un archivo de hoja de célculo (spreadsheet)

24



Agregando un Arreglo al Panel Frontal

Desde la sub-paleta de Controls >> All Controls
>> Array and Cluster , seleccione el Array Shell

1 LIST|

E a1 Array & Cluster
[Frar]!
EEI\UM’

5“ £ m

=

Coléguelo en la pantalla.

Agregando un Arreglo (cont.)

Situé el objeto de datos dentro del shell (Ej. Control Numérico)

B Numeric Controls

25



Creando un Arreglo con un Ciclo

*Los ciclos acumulan arreglos en sus limites.

EEX

L

1> Untitled 2 Block Diagram ™
File Edt Operate Tools Browse ‘indow Help

loul'?ln’ 13pt Application Font | = . M@
|

I3 Unfited 2 Front el FEX

7|

Replace with shift Register
Express Numeric Palette b
Array Palette 3
Creats »

Creando Arreglos Bidimensionales (2D)

&l Untitled 2 Block Diagram *

File Edit Operate Tools Browse MWindow Help E
[>]@] @[n][2][ba]@]o# [ 130t application Fon: |~ ][5~ ][55a~] [£5~]
|

EHN

EHN

ED Arra
Fandam Mumber (0-1

26



—
Manejo de Archivos (File 1/0)

Manejo de Archivos - transferir datos a y desde archivos
- Los Archivos pueden ser binarios, texto u hojas de calculo

- Escritura/Lectura de Archivos de Medicion de LabVIEW
(LabVIEW Measurements — *.lvm)
Escritura en Archivo LVM Lectura de un Archivo LVM

¥

[+
¥
: B
: | :
3 Write LabWIEW
L3

FY T

[+
Read LabVIEW

ki i

¥ Measurement
Simnulate Signal Fils Meas;la:ment _2 avefarm Graph]
Sine - Signals Signals
¥

INSTRUMENTS

Escritura de Archivos de Medicion LaEaiEW

(LabVIEW Measurement)

* Incluye las funciones de apertura, escritura, cierre y manejo de errores

* Maneja el formateo de cadenas de caracteres (strings) ya sea con
delimitacion por medio de tab o de coma

+ La funcién de concatenar sefiales es usada para combinar datos en
datos de tipo dinamico

EHN

¥
) "

Wrike LabVIEW 0 0.385055

Measurement File 1 023518
Signals 2 0.985184

3_0.1778593
41 05355150

|| | ha =

Fandom Mumber {0-1)

INSTRUMENTS
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Ejercicio 4 — Analizando e Introduciendo Datos

Los Estudiantes construyen el VI Logger de Temperatura.vi

& Logger (Ex4),vi Block Diagram * (=113

Tools B tindow  Hel =
e Tools Browse Window Help
Al

1 ﬂ@ L!_Ui’?lﬁ_ﬂ 130t Application Font "iL’-m_'l@ E’:]

Seccion VI - Funciones de Arreglos y Graficos

* Funciones Basicas de los Arreglos
» Uso de graficos
* Crear Diagramas Mudltiples con Gréficos

28



Funciones de los Arreglos — Lo Basico

Functions>> All Functions>> Array

B Untitled 9 Front Panel *
titled 9 Block Diagram *

&
B

[

Funciones de los Arreglos — Construccion de un Arreglo

k> Build Array.vi Block Diagram ™ \Z”EH?\ £ Build Array.vi Front Panel *

File Edk Operats Tools Browse Window Help Flle Edt Operate Tools Browse Window Help
2
]

E‘E 13pt Application Font \vl 5;,'1 T

LD Arra
Build Arra:
=g
ﬁ
o

[array with
Lone Element] nserted Element|

Build Arra

=

(.=




Graficos

* Seleccionados desde la Paleta de Controles del Menu
Controls >> All Controls >> Graphs

Grafico de Forma de Onda
(Waveform Graph3}- Grafiica wm 4 [ @ search
arreglo de numeros en contra de sus
indices rH| Em
Grafico XY Expreso (Express XY ——
Graph)— Grafica un anray en contra -
de otro

Grafico de Forma de Onda Digital ®i@ @
(Digital Waveform Graphy-
Grafica bits de datos binarios

No borrar esta Diapositiva
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Graficos

> Waveform Graph Properties: Waveform Graph
—++
— = EHL
..... — " o oa Painkjfill
—_ 11
== amm " *t JL Fillo
B —
Vescale | Ampltude (V-Rods) v

E5]

Haga Clic Derecho en la grafica y seleccione Properties

(propiedades) para poder personalizar interactivamente

Ejercicio 5 — Usando Graficos de Forma de Onda
(Waveform )

5 Multiplot

y
Ele Edit Cperate Browse Window Help

o] 0 0] ] el [ s [t [ [
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denas de Caracteres,
& Manejo de Errores

+Cadenas de caracteres
*Creando Clusters
*Funciones de los Clusters
*1/O Error

Cadenas de caracteres
* Una cadena es una secuencia de caracteres desplegables o
no desplegables (ASCII)
» Tienen muchos usos - despliegue de mensajes, Control de
instrumentos, Archivos de entrada y Salida (1/O)
« El controlador/indicador de cadenas se encuentra en
Controls »Text Control o Text Indicator

|f vou have large
amounts of text you
can minimize the

zpace taken up by
the string contral by
showing the
gorollbar.

32



Clusters
* Estructura de Datos que agrupa datos juntos.

Los Datos pueden ser de diferentes tipos.
» Semejante a una estructura (struct) en C++

Los elementos deben de ser ya sea, todos
Controles o todos Indicadores

* Se puede considerar como un conjunto de
alambres agrupados en un cable.

— I

Creando un Cluster
1. Seleccionar la pre-forma (shell) del Cluster

Controls >> All Controls >> Array & Cluster

2. Colocar Objetos dentro de la pre-forma (shell)

=1 All Cantrals
Array & Cluster

¥ ¥ [aba]
}123 ‘.
5

33



Funciones del Cluster

» Estan ubicadas en la subpaleta de Cluster de la
paleta Functions>>All functions

+ También puede ser accesada haciendo clic con el
botén derecho del mouse en la terminal del Grupo.

component 0 —gmrg
companent 1 CIUStE[
(Las etiquetas de la

terminal reflejan los

Bundle tipos de datos)

(Agrupar)

input cluster

|abc[3

new component & | owned label &
new component B~ owned |abel B

output clusker

Bundle by name
(Agrupar por nombre)

i
Funciones del Cluster
[ TEme component O
cluster component 1
Unbundled
dliggital contral
fseparan st
swvitch 2
string control
Unbunclle By Mame]|
st 2 peeeeee
P | ztring cortrol preeasnenns
dlabel & — component &, ]
chister=p [ el B}~ component B prvp

Unbundled by name
(separar por nombre)

Ejemplo de un
Cluster separado
(Unbundled Cluster)

34



Errores de Cluster

* Los Errores de Cluster contienen la siguiente informacion:
—Booleano (Boolean) Para reportar si surgio algun error

—Enteros (integer) Para reportar errores especificos de codigos
—Cadena (string) Para brindar informacién acerca del error

Técnicas de Manejo de Errores

* La informacién de un Error es transmitida de un subVI al siguiente

* Si un Error ocurre en un subVI, todos los subVI subsecuentes no
seran ejecutados de la manera usual

* Los errores de Cluster contienen todas las condiciones del Error
» Manejo automatico de Errores

S\mﬁle Error Handler.vi

T
code

source Fode]

T

Errores de Cluster

EE
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Seccion VIII - Estructuras de Caso y Secuenciales,
Nodos de Formula

Estructuras Caso

* En la subpaleta de estructura de las paleta de funciones.

* Encerrar los nodos o arrastrarlos hacia adentro de la
estructura.

» Colocados como un juego de cartas (naipes), solo un caso
es visible a la vez.

a0, Defaul_~ ]

36



Ejercicio 6 — Errores de Cluster y su Manejo

5! Square Raot.vi Block Diagram * fEX

Fle Edit Operate Tools Browse iindow Help =0
0
&

sa @] [ 120t pptcaton ort._ |- [ B [5a- [85-][ 2
(% Leooe PlFalse ~Hf Square Root Value
Greater Or
Equal To 07

Mumber
99999.0
Square root ) =
- [

_____________________ B
[Error in (no error; Ertor ot |

1
[y e i
'“Fﬂ id & |- skatus ==
5005 H code
|Square root | source

Estructuras de Secuencia

* En la subpaleta de control de ejecucion (Execution
Control ) de la paleta de funciones.

* Ejecuta diagramas secuencialmente.

* Presionar boton derecho del mouse para agregar un
nuevo cuadro (frame).

& Functions—— Qsearch| | pOooooooooooorooOOEOEEEOEETEOOOE IO H O TET

= % B - @

Bigvefom Graph|
Input Anzlysis Output User Libraries. ARG aveform Graph

data e G
72

While Loop ~ FlatSequence  Case Structure

Time Delay Elapsed Time




Nodos de Formula

* En la subpaleta de Estructuras (Structures).

* Implementa ecuaciones complicadas.

* Variables creadas en los margenes

* Nombres de variables son sensibles (mayusculas/mindsculas)
» Cada declaracion debe de terminar con un punto y comaf;)

* La ventana de ayuda muestra las funciones disponibles.

i Note el Punto y coma

B

INSTRUMENTS

Seccion IX — Documentacion e Impresion

* Imprimir desde el Menu de Archivo (File Menu) hacia:
la Impresora, HTML, Archivos de Texto.

* Imprimir programaticamente Graficas o Imagenes del
Panel Frontal

*Documentar los Vs en VI Properties » Documentation
Dialog

* Agregar Comentarios usando etiquetas libres dentro
del panel frontal y diagramas de bloques.

INSTRUMENTS
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Impresion

* File » Print... Da muchas opciones de impresion

— Seleccione la Impresion del Icono, el Panel Frotal, el Diagrama de
Bloques, La Jerarquia del VI, SubVIs Incluidos, Historia del VI

* Print Panel.vi (Programaticamente imprime un Panel Frontal)
— Functions » All Functions » Application Control

* Generar e Imprimir Reportes (Functions » Output » Report)

e sl = R 1 8

SrTOr in (N0 error) seessssmmsk
Enabled? -7

Report
v Sdditional Comme

Additional Comments
Signal | seeemeomcomced Signal 1

Signal & seceescoccoeeds Signal 2
il

e
Documentando Vs

* VI Properties » Documentation
— Provee una Descripcion e Informacion de Ayuda para el VI
* VI Properties » Revision History
— Monitorea cambios entre diferentes Versiones de un VI
* Individual Controls » Description and Tip...
— Haga clic con el bot6n derecho del mouse para proveer una
descripcion y ayuda (Description and Tip Strip)
« Utilice la herramienta de etiquetado (Labeling Tool) para
documentar paneles frontales y diagramas de bloques

INSTRUMENTS
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Seccion X — Arquitectura Basica de Programacion

* Arquitectura VI de un simple
* Arquitectura de un VI General
* Arquitectura de maquina de estado

| Arquitectura de un VI simple

+ VI funcional que produce resultados al ser ejectado
—No tiene opciones para “comienzo” o “fin”
—Adecuado: para pruebas de laboratorio, calculos

* Ejemplo: Convertir C a F.vi

5! Convert C to F.vi Block Diagram * (=]t3]
File Edit Operate Tools Erowse ‘Window Help E

|@|£| “-Inl'ﬁ'lnf” 13pt Application Font ©

degC
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Arquitectura de un VI General

* Tres pasos principales
— Inicio

— Aplicacién principal

— Cierre (shutdown)

|

Enter veur code here]

| Arquitectura de Maquina de Estado

* Ventajas

— Puede ir de cualquier estado a otro

— Facil de modificar y depurar
* Desventajas

— Se pierden eventos si dos ocurren al

mismo tiempo

Pasos:
0: Inicio (Startup)

1: Ocio (ldle)

2:Evento 1
3: Evento 2
4: Cierre (Shutdown)

T "Startup”, Default
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Ejercicio 7 — Simple Maquina de Estado

[ Iritilize”, Default_*f

[This template is For the Standard State Machine design pattern,

[Each Frame of this case structure executes cod For its state and
lcomputes what state ko transition to next.

|States are represented as values of an enumeration, These enumerations are instances
of & type definition s that states can be quickly added, To ed the

ltype definition, tight lick on an and select Open Type Def.
State et State
P [ State L 7]

No Borrar Esta Filmina
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=
Seccion XI - Panel Frontal Remoto

*Observary Controlar Paneles Frontales de LabVIEW
desde un Navegador en la Web

*No Requiere Programacion

* Usuarios en lugares Remotos pueden ver en Tiempo
Real las Actualizaciones del Panel Frontal

* Multiples clientes pueden Observar el Panel Frontal
Simultaneamente

+* Solo un Cliente Puede Controlar el Panel Frontal a la
vez

INSTRUMENTS

Herramienta para la Publicacion de un Panel Remoto

*Tools » Web Publishing Tool

*Clic Salvar a Disco y el -

VI es embebido a un He Lods Midon Eob
archivo HTML htel e sanmle image (ot uptere)

Document Title

Text 1 Text that is going to De displayed
Text that is going to be displayed before the image of the YIPanel. . | ufore the image of the VI psnsl

*Después que el

archivo a sido grabado, 7 4
puede ser reabierto y Erbecied 7] o oder
personalizado en
i i Text that is going to be displayed after the image of the VI Panel. J
cualquier editor HTML
=l
Start Web Server Help | Done ‘
INSTRUMENTS
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Panel Frontal Remoto - Recursos

* NI Developer Zone
(zone.ni.com)

— Busque Remote Front
Panel

— Tutdriales e Instrucciones
estan disponibles para
descargar (download).

— Informacién para poder
Incorporar una camara
Web en aplicaciones con

panel remoto.

Seccion Xll - Temas Adicionales

*Nodo de Propiedad
*Variables Locales
*Variables Globales

* DataSocket

|+ Archivos Binarios I/0
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| Qué hago Ahora?

* Ejemplos de Programas (Help» Find Examples...)

+LabVIEW Edicién de Estudiantes
(www.ni.com/labviewse)

*Recursos Web (ni.com)

—Zona de Desarrollo NI (zone.ni.com)

—Notas de Aplicaciones

— grupo de noticias labview (www.info-labview.org/)

— Instrument Driver Library (www.ni.com/idnet)
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